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INTRODUCTION 
 
This document was created using the Accessible Digital Office Document (ADOD) 
Project and resources developed by the Office of the Governor Rick Perry, the State of 
Texas. 
 
The ADOD Project was developed by the Inclusive Design Research Centre, and 
OCAD University as part of an Enabling Change Partnership project. 
 
The purpose of this document is to ensure that County of Elgin public documents are 
created in a way that allows them to be viewed by assistive devices.  
 
This is a training manual and reference document for staff.  
 
The software described in this manual includes: 
 

• Microsoft Office 2010 and; 
• Adobe Acrobat Professional Version 10 (X) 

 
Sighted people can look at a printed page and easily discern the difference between 
titles, subtitles, columns of text, headers, footers, and so on. Visual cues, such as 
location of the text on the page, bold text, and large font sizes help them determine the 
structure of a document so they can read and navigate it easily. 
 
Unfortunately, assistive technologies such as screen readers can’t depend on these 
visual cues. They must instead rely on the underlying computer-based information to 
provide that same structure. 
 

DISCLAIMER 
 
Following these techniques will increase the accessibility of your documents, but it does 
not guarantee accessibility to any specific disability groups.  In cases where more 
certainty is required, it is recommended that you test the office documents with end 
users with disabilities, including screen reader users. 
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GENERAL 
 
TIPS AND BEST PRACTICES 
 
The following rules can be applied to most documents created in Microsoft Word, Excel 
and PowerPoint: 

• Design the source document with accessibility in mind; 
• Use program styles available in the application rather than character 

formatting for headings; 
• Add alternative text to all graphics and images; 
• Create the PDF in a manner that generates tags; 
• Check the accessibility of a document using the Accessibility Check in 

Office or, after conversion using the Full Check feature in Adobe Acrobat 
Professional (available in both version X or XI) 

• When adding accessibility features to a document they should always be 
added to the source document first (if possible) as it is often faster and 
easier. 

 

STYLE GUIDELINES 
When formatting text, especially when the text is likely to printed, try to: 

• Use font sizes between 12 and 14 points for body text. 
• Use fonts of normal weight, rather than bold or light weight fonts.  If you do 

choose to use bold fonts for emphasis, use them sparingly.  
• Use standard fonts with clear spacing and easily recognized upper and 

lower case characters. Sans serif fonts (e.g., Arial, Verdana) may 
sometimes be easier to read than serif fonts (e.g., Times New Roman, 
Garamond). 

• Avoid large amounts of text set all in caps, italic or underlined. 
• Do not condense or stretch lines of text. It is recommended that text align 

to the left margin as it is easy to find the start of the next line, and keeps 
the spaces even between words. (“Ragged Right” is the best approach) 

• Use bullets and numbering to create lists and outlines 
• Choose a sharp colour contrast for all elements of a document 
• Avoid using text boxes 
• Set font colour to “automatic” or “black” 
• Use heading styles to control line spacing rather than the enter key 
• Place white space between text and graphics/images 
• Do not use watermarks or backgrounds 

 
By taking the time to design your content in a consistent way, it will be easier to access, 
navigate and interpret for all users: 

• Whenever possible, write clearly with short sentences. 
• Introduce acronyms and spell out abbreviations. 
• Avoid making the document too “busy” by using lots of whitespace and by 

avoiding too many different colors, fonts and images. 
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• If content is repeated on multiple pages within a document or within a set 
of documents (e.g., headings, footings, etc.), it should occur consistently 
each time it is repeated.   

• Ensure text for links is descriptive (e.g. don’t use “click here”)  
 
*This general section of this document provides techniques that can be used in 
any of the Microsoft Office programs.   

CHECK ACCESSIBILITY 
 
The accessibility checker assists with finding accessibility errors in Word, PowerPoint 
and Excel. 
Although the checker can find a variety of issues, it cannot find every possible error. If 
you get a clean bill from the accessibility checker, you still need to follow the rules for 
creating accessible Office files. 
 
*Note – in order to use the accessibility checker, your file must be saved as a 
.docx 
 
The “Accessibility Checker” classifies issues as 

• Error – content that makes a file very difficult or impossible for people with 
disabilities to understand 

• Warning – content that in most, but not all, cases makes a file difficult for 
people with disabilities to understand 

• Tip – content that people with disabilities can understand, but that might be 
better organized or presented in a way that would maximize their experience 

 
1. To use the “Accessibility Checker” 
2. Go to menu item: File  
3. Select Info in the left window pane 
4. Under Prepare for Sharing, an alert will appear if a potential accessibility issue 

has been detected
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To view and repair the issues, select Check for Issues and 
then Check Accessibility 

1. An Accessibility Checker task pane will open, showing the 
inspection results  

2. Select a specific issue to see Additional Information  
3. Follow the steps provided to fix or revise the content 

 
The task pane is divided into two sections: Inspection Results and 
Additional Information.  
The Inspection Results section shows the list of accessibility 
issues found in the document.  If you click on the issue, the 
Additional Information section gives you details on why this is a 
problem and tips on how to fix it. 
 
You should correct all of the issues listed, if possible.  If you have 
any questions, ask your Municipal Accessibility Specialist. 
 
Now that the checker has given you a list of issues, what do you 
do? 
Let’s look at an error listed by the checker.   
Notice that the issues are listed in categories.  The first category 
in our list is Missing Alt Text.  Alt text must be provided for any 
element that cannot be fully described by a screen reader.  In this 
example, there are 11 pictures that are missing Alt Text. 
 
To find the error in the document, click on an element in the error 
list.  Word will move to the place in the document where the error 
was found.  By clicking on Picture 2, the picture moves to the top 
of the window.  
 
If you are unsure how to fix the error, remember that the checker 
also provides more information.  If the Additional Information area 
is not visible, click on the up-arrow character next to the Additional 
Information heading at the bottom of the task pane.  The 
additional information not only explains why the problem should 
be fixed, but how to fix it. 
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COLOUR CONTRAST 
 
Appropriate colors and contrast are necessary for people to see our words and 
understand their meaning. This is especially true for people who are colorblind or have 
other visual disabilities. 
 
We create documents to communicate. We invest our time organizing our thoughts and 
carefully choosing our words so we can deliver a clear, concise message. If we then put 
it all down in a way people cannot read or understand, we have not done our best at 
communicating. 
 
There are two very simple rules when it comes to color and contrast in our documents: 

Rule 1: Do not ask your reader to make a choice based on color alone 
If color is used as the only visual means of conveying a message, asking for a 
response, or identifying a visual element, then what is a person who is colorblind to do? 
 
Let’s suppose for a moment that you are asking your reader to make a choice based on 
color. Your closing line may go something like, “If you want to generously donate your 
next paycheck to my favorite charity, sign in the green box. If you prefer to donate the 
five dollar minimum, sign in the red box.”  

Where should the colorblind reader sign? Most likely, they won’t sign at all. 
If you do choose to add color or shading to your document, make sure that the 
information conveyed in color is also available without color. In the prior example, you 
might add the appropriate text to the two boxes just to be sure the message is clear. 
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Rule 2: Use sufficient contrast 
A recent design trend involves presenting grey text in small, sans serif fonts on a white 
background.  People with visual disabilities, including those with aging eyes, cannot 
read this. In fact, even people with perfectly good eyesight have some problems with 
this. 
 
In most cases, it is enough to say we must use sufficiently contrasting foreground and 
background colors. But, for those who want a more exacting definition, here is some 
help. 
Text should have a minimum contrast ratio of 4.5 to 1. This is the minimum ratio, not the 
recommended one.   

AVOID USING IMAGES OF TEXT 
 
Before you use an image to control the presentation of text (e.g. to ensure a certain font 
or colour combination), consider whether you can achieve the same result by styling 
“real text”. 
 
If this is not possible, as with logos containing stylized text, make sure to provide 
alternative text for the image following the techniques noted above. 
 
Logos using the corporations name are acceptable in most cases; however, try to limit 
the information to only the corporation’s name.  
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WRITE CLEARLY 
 
By taking the time to design your content in a consistent way, it will be easier to access, 
navigate and interpret for all users. 
 

• Whenever possible, write clearly with short sentences. 
• Introduce acronyms and spell out abbreviations.  
• Avoid making the document too “busy” by using lots of whitespace and by 

avoiding too many different colours, fonts and images. 

To turn on Readability Statistics  
 

• Select the Office Button 
• Select Word Options 
• Select Proofing 
• Ensure Show Readability Statistics box is checked 
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To check your grade level 
 

1. Select the Review tab 
2. Select Spelling and Grammar 
3. When spell check is complete, your grade level will pop up in a dialogue 

box. 

Reading Ease 
• Paragraphs with a high “reading ease” tend to be easier to read. 
• Scores 0 – 100 
• Plain English = 65 

Grade Level 
• Paragraphs with a lower “grade level” tend to be easier to read. 
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DOCUMENT PROPERTIES 
 
In case the document is ever converted into HTML, it should be given a descriptive and 
meaningful title.  

To change the title of the current document 
1. Go to menu item: File> Info > Properties 
2. In the Document Properties section that appears, select the Title text 

box 
3. Enter the Title 

Note: The Title defined in the properties is different than the file name. 
  

TEMPLATES 
All office documents start with a template, which can be as simple as a blank standard-
sized page or as complex as a nearly complete document with text, graphics and other 
content. For example, a “Meeting Minutes” template might include headings for 
information relevant to a business meeting. 
 
Because templates provide the starting-point for so many documents, accessibility is 
critical. If you are unsure whether a template is accessible, you should check a sample 
document produced when the template is used. 
  
It is possible to create your own accessible templates from scratch in Office 2010.  As 
well, you can edit and modify the existing pre-packaged templates, ensuring their 
accessibility as you do so and saving them as a new template. 

To create an accessible template 
1. Create a new document (from the default blank template or from one of 

the pre-packaged templates) 
2. Ensure that you follow the techniques in this document 
3. When you are finished you should also check the accessibility of the 

document (See Technique 10, below) 
4. Go to menu item: Office > Save As > Word Template 
5. Save the template in the Microsoft > Templates folder 
6. In the File name box, type a name for the template.  Using a 

descriptive File name (e.g., “Accessible Memo Template”) may increase 
the prominence of the accessibility status.  As well, filling in the text box 
labelled Tags with the term “accessibility” may improve its searchability as 
an accessible file. 

7. Select Save 

To select an accessible template 
1. Go to menu item: Office > New 
2. Under Templates, select My templates… 
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3. In the New document dialog, select your accessible template from the list 
in the My Templates tab 

4. Select OK 
5. A new document based on the template will be displayed. If you have 

chosen an accessible template, the document will be accessible at this 
point. As you add your content (e.g., text, images, etc.), ensure that you 
consult the sections that follow to preserve accessibility. 
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HYPERLINKS 

Use Meaningful Link Text 
Modern screen readers are able to make a list of all the links inside a document. This 
helps the user quickly find the link they are looking for. If the link text is meaningful, the 
right link is easily found. 

 
All too often, we see links in a document with the text “Click Here”. If the author writes 
“Click Here” for all links, guess what the screen reader will say? That’s right, a tiresome 
refrain of “Click Here, Click Here, Click Here.”  
 
When we link with words like “Click Here” or “Read More,” we aren’t giving the user any 
useful information about that link. And that’s not accessible.  
 
To make the links accessible, use contextual links, or links made of meaningful 
words that describe the hyperlink. Use concise and descriptive text and not the 
actual hyperlink address or URL. In fact, the Word Accessibility Checker will flag 
URLs as unclear text.  
 
To make a hyperlink, follow these five simple steps: 

• First, select the meaningful text that will be used for the link. 

• Then, click on Hyperlink in the Insert ribbon. 

• Next, select the appropriate Link to choice on the left side of the Insert 
Hyperlink dialog box. You can also verify your text selection at the top of the 
box. 

• Now, add the complete URL in the Address field at the bottom and click OK. 

• Finally, check that your link goes to the proper location. 

• If linking to internal documents, make sure the document will only be used on 
internal server systems.  



13 
 

MICROSOFT WORD 
STYLES 
You should attempt to make use of the named styles that are included in Microsoft 
Office.  Styles make a document easier to navigate for users of assistive technology. 
 
Word includes a number of built-in styles that are always available, some of which are 
key to using different Word features. For example, Normal style is the default paragraph 
style for all text in your Word document.  
 
Normal is the style on which most other paragraph styles are based. That means if you 
change Normal style (such as changing the font style or size), many other styles will 
automatically change to match. As you can imagine, this kind of link between styles can 
be incredibly useful. It can also be incredibly frustrating if used incorrectly. 

 
Perhaps the most dynamic of the built-in styles are the paragraph styles Heading 1 
through Heading 9.  Styles can be found by clicking on the “Home” tab. 
 
There are two types of styles: 
 

• Paragraph Styles (also known as block styles) are identified by the 
paragraph symbol after the style name.  To apply a paragraph style, place 

your cursor anywhere in the paragraph in front of the paragraph marker, and 
click the style name. 

• Character Style are identified by the lower-case “a” after the style name. To 
apply a character style, highlight the desired text, then click on the style 
name. 

 
When applying styles, remember that the last applied style determines the formatting. 
Also, when you apply a character style over a paragraph style, the character style will 
be dominant. 
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HEADINGS 
 
Documents that are longer than a few paragraphs require structuring to make them 
easier for readers to understand.  The easiest way to do this is to use “Headings”.  
Headings create logical divisions between paragraphs.  Headings are structural 
elements that provide a meaningful sequence to users of assistive technologies. 
 
Headings can be found under “Styles” in the Home Ribbon in Microsoft Word. 
 
Headings orient a user to a particular section or element. 
 
It is important that you use the numerical order of headings within your document.  You 
can only have one Heading1; followed by Heading2 etc.  You can have multiple 
Heading2 or Heading3. 

To modify a style/heading: 
1. Right click on the style 
2. Select Modify 
3. In the Modify Style dialog make the appropriate changes to the style 
4. Select OK 

 

 

To apply a heading: 
1. Highlight the text you wish to apply the heading to. 
2. Select the appropriate heading from the Styles List. 
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ALTERNATE TEXT (ALT TEXT) 
When using images or other graphical objects, such as charts, tables and graphs, it is 
important to ensure that the information you intend to convey by the image is also 
conveyed to people who cannot see the image.  This can be done by adding alternative 
text to each image.  If an image is too complicated to concisely describe in the 
alternative text alone (flowcharts, etc.), you should provide a short text alternative and 
longer description as well. 

To add alternative text to images, tables and graphical objects 
 

1. Right click the object 
2. Select Format Picture, Table Properties or Size 
3. Select the Alt Text tab in the Size dialog 
4. Fill in the Alterative Text under Description (leave the “Title” blank) 
5. Close 

 
 
 

If your document 
originated in an earlier 
version of Word, it will 
open in the Compatibility 
Mode and the process 
will be slightly different. 
When the Alt Text dialog 
box opens, select the Alt 
Text tab, then enter a 
brief description in the 

alt text field.  
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IS A PICTURE REALLY WORTH A THOUSAND WORDS? 
 
Sometimes figures are extremely important to the content of a document.  They provide 
nonverbal information to readers. As the document author, you must decide whether a 
picture contains information that will be useful to the reader of the document. 
 
If the information in an image adds meaning to the document, explain the figure 
succinctly but accurately in the alt text.  However, if an image is there merely for 
decorative purposes and does not add meaning to the text, type a pair of quotation 
marks (“”) in the alt text. This lets the reader know that the alt text was not forgotten. 
 
If you add a very complex image, such as a graph or chart, it may not be possible to 
describe the picture in a few words. If that is the case, it may make sense to repeat the 
information from the image in that page text that follows the image. Everyone who reads 
the document can then focus on the important information found in the image, including 
assistive technology users.  For example, if a graph of quarterly earnings is followed by 
a paragraph that describes the earnings report, then the alt text for the image might just 
say “quarterly earnings, details to follow in page text”.  

Tips for writing alternative text 
• Try to answer the question “what information is the image conveying?” 
• If the image does not convey any useful information, think about not using the 

image at all. 
• If the image contains meaningful text, ensure all of the text is replicated 
• Alternative text should be fairly short, usually a sentence or less. (rule of 

thumb 40-60 characters) 
• If more description is required, provide a short description in the alternative 

text and more detail in the long description 
• Test by having others review the document with images replaced by the 

alternative text 
 
LONG DESCRIPTIONS 
Long descriptions should be use when text alternatives are insufficient to answer the 
question “what information is the image conveying?”. 

• In some situations, the information being conveyed will be how an image 
looks.  In these cases, try to describe the image without making too many 
of your own assumptions. 

• One approach is to imagine you are describing the image to a person over 
the phone. 

• Ensure that you provide a concise alternative text to help readers decide if 
they are interested in the longer description. 

 
Long descriptions can be used in place of alt text and used when more information is 
required to explain a chart or graph. 
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LISTS 
 
When you create lists, it is important to format them as “real lists”.  Otherwise, assistive 
technologies will interpret your list as a series of short separate paragraphs instead of a 
coherent list of related items.  
 
You can apply the list style before or after you type the list.  If you choose to type first, 
highlight the list when you are done and click on the style of your choice. 

To create an ordered or unordered list 
1. Go to menu item: Home 
2. In the Paragraph section, select the Bullets icon for unordered list or 

select the Numbering icon for ordered lists 
3. To choose a different list format, select the arrow beside the icon 
4. Select a format from the format Library that appears in the drop-down 

menu. 
 

PAGE BREAKS 
 
The Page Break feature is very important for assistive technology.  Whenever you need 
to start a new page, select the Page Break feature instead of repeated hard returns 
(enter key). 
 
Page Breaks can be found under the Insert tab, or for other types of Breaks, click on 
the Page Layout tab and choose the down arrow beside Breaks. 
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TABLE OF CONTENTS 
 
Creating an index or table of contents to outline office documents can provide a means 
of navigating the content in a meaningful sequence.  
 
The best way to generate a table of contents is after applying the predefined heading 
styles, such as “Heading1” to the headings that you want to include in your table of 
contents.  After you apply these styles, you can then create a table of contents.  
 
When headings are organized in a table of contents, the reader can quickly review the 
information contained in the document.  Like the document navigation map, a table of 
contents outlines structure and allows for quick navigation.  From the table of contents, 
you can skip to a certain topic by pressing the control key and clicking on the heading. 

To insert a Table of Contents 
1. Place the cursor in your document where you want to create the table of 

contents. 
2. Go to menu item: References 
3. In the Table of Contents section, select Table of Contents 
4. Select the style that you want to use 

 

To update the Table of Contents 
1. Select the table 
2. Go to menu item: References 
3. In the Table of Contents section, select 

the Update Table button 
 
Select the type of table you would like to insert: 

a. Automatic 
b. Manual or; 
c. “Insert” (this option gives you the ability to 

control the properties of the table) 
If you use a manual table, you must add 
the title of each item and enter all updates and changes yourself. 
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TABLES 
 
Tables can be great for presenting data, but we need to avoid using tables simply to 
format other content. 
When using tables, it is important to ensure that they are clear and appropriate 
structured.  This helps all users to better understand the information in the table and 
allows assistive technologies (e.g. screen readers) to provide context so that the 
information within the table can be conveyed in a meaningful way. 

Tips for tables 
• Use “real tables” rather than text formatted to look like tables using the TAB 

key or space bar.  These will not be recognized by assistive technology. 
• Keep tables simple by avoiding merged cells and dividing complex data sets 

into separate smaller tables, where possible.  Whenever possible, use just 
one row of headings. 

• Create a text summary of the essential table contents.  Any abbreviations 
should be explained in the summary. 

• Table captions or descriptions should answer the question “what is the table’s 
purpose and how is it organized?”. 

• Table cells should be marked as table headers when they serve as labels to 
help interpret the other cells in the table. 

• Table header cell labels should be concise and clear. 
• Avoid merging or splitting cells, where possible.  
• Do not control spacing in your table with blank rows or columns. Adjust line 

spacing instead. 

To add a table with headings 
1. Go to Insert tab 
2. Select the Tables icon 
3. Select the number of rows and columns you would like your table to have 
4. Select the table and a Table Tools menu item should appear 
5. Go to menu item Table Tools >Design 
6. In the Table Style Options section, select 

the Header Row Check box 
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SETTING THE TABLE 
Before you insert your table, it’s a good idea to know how many columns and rows you 
need.  Remember to allow for the column headers.   
The width of your columns should also be given some consideration, so that the table 
does not exceed the width of the page. For some tables you may need to change the 
page orientation to landscape to give yourself more room horizontally. 
 
MIND YOUR TABLE MANNERS 
 

• Give your table a title using the Caption tool.  Make sure the label field 
indicates 
that this 
is a 
caption 
for a 
table. 
Identify 
the 
header 
row. 
Here’s 
how: 

1. Select just the top row of your table, right click and choose Table 
Properties 

2. Select the Row tab 
3. Check the box labelled Repeat as header row at the top of each page  
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Select a table style that sets the text, background and grid colours for the table. When 
selecting a style, consider the following issues: 
 

• Be sure there is enough contrast between the text and background colours of 
each cell.  

• Choose a table style that provides grid lines to separate the data cells. If 
someone is using a screen magnifier to view the table, the grid lines help 
them follow each row across the page, especially if there is a lot of space 
between the text in adjacent cells.  The grid lines are also useful for 
separating cells if there is a lot of text. 

 

Use simple data tables. Never merge two or more cells into a single larger cell or split 
into smaller cells.  The table should be a simple grid with predictable rows and columns. 
Complex table structure is nearly impossible to follow with a screen reader. 

 
 
 

Provide column headers for your data table. This helps people understand the meaning 
of each column of data.  Type the column header text into the first row of the table, and 
be sure to select the Header Row option on the Table Tools Design tab.  
 
Add alt text to make your table more accessible. To add alt text, right click within the 
table, select the Format Shape option, and then select Alt Text tab. 
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CHARTS 
Charts, graphs, and other complex images may contain so much information that it is 
difficult to sufficiently describe them with Alt Text. 
 
You can approach this problem in several ways. 

• First, consider whether it is possible to simplify the chart, or split it into multiple 
charts, so that each one contains a smaller amount of information. This will not 
only simplify the alt text required for each chart, but will make the information 
more understandable for everyone in your audience.  

• If the image is still too complex to describe the alt text, you will need to provide a 
text description elsewhere. (One possibility is to add the full description to the 
Notes section if using PowerPoint). If you do this, add alt text to the picture with a 
very short description of the picture, and end with the words "Full text description 
in the Notes section of this slide." You can even place that note on the slide itself, 
so even people who do not use screen readers can find the text description. 
 

• Another possibility for describing a complex picture is to type the description into 
a text box placeholder on the slide, and then place the picture OVER the text, so 
that only the picture is visible on the page. The screen reader will announce the 
hidden text even though it is not visible on the page.  
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MICROSOFT POWERPOINT 

USE BUILT-IN LAYOUT AND STYLING FEATURES 
 PowerPoint 2010 does not offer “True Headings” or “Named Styles” as does Word 

2010. 

USE BUILT-IN SLIDE LAYOUTS 
Instead of creating each slide in your presentation by starting from a blank slide, check 
whether there is a suitable built-in layout.  
 
Note: The built-in layouts can be more accessible to users of assistive technologies 
because technologies sometimes read the floating items on the slide in the order that 
they were placed on the slide. The built-in layouts have usually taken this into account 
(e.g., “Title” first followed by other items, left to right and from top to bottom). If you 
create slide layouts from scratch, it is sometimes difficult to keep track of the order 
elements were placed. 

To apply “true layout” to a slide 
1. Go to menu item: Home 
2. In the Slides section, select the Layout button 
3. Select the layout you would like to use from the drop down menu 
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CUSTOMIZE USING MASTER SLIDES 
If a layout must be customized, it is recommended that Master Slides be used. 
 
Every slide layout in a presentation is defined by its master slide.  A master slide 
determines the formatting style for various elements of the slide layout.  This includes 
font styles, character formatting, and the positioning of elements.  Essentially, each 
master slide acts as a design template for the slide layout. 
 
If you edit any aspect of the slide layout in the master slide, the change will affect all 
slides that were created based on it.  For this reason, it is good practice to edit the 
master slide and use the slide layouts before building individual slides.  It is essential 
that you create and use master slides that meet the accessibility requirements outlined 
in this document. 

To create or customize a master slide 
1. Go to menu item: View 
2. In the Presentation Views section, select the Slide Master icon 
3. The current slide master with its associate layouts appears 

Note: If you have the Normal view open, the slide master is the larger slide 
image in the slide thumbnail pane.  The associated layouts are positioned 
beneath the slide master. 

4. Customize the existing master slide and its associated layouts to suit your needs 
(e.g., apply a design, theme-based colors, fonts, effects, backgrounds) ensuring 
that your changes meet accessibility requirements 

5. Go to menu item: Office > Save As > Other Formats 
6. In the File name box, type a file name 
7. In the Save as type list, select PowerPoint template 
8. Select Save 
9. On the Slide Master tab, in the Close section, select Close Master View 
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SET A LOGICAL TAB ORDER 
Many presentation applications create content composed almost exclusively of "floating" 
objects. This means that they avoid the transitions between in-line content and 
secondary "floating" objects (text boxes, images, etc.) that can cause accessibility 
issues in word processors.  
 
However, when you are working with "floating" objects, it is important to remember that 
the way objects are positioned in two dimensions on the screen may be completely 
different from how the objects will be read by a screen reader or navigated using a 
keyboard. The order that content is navigated sequentially is called the "Tab Order" 
because often the "Tab" key is used to navigate from one "floating" object to the next. 
 
Tips for setting a logical “tab order” for "floating" objects 

• The tab order of floating objects is usually from the “lowest” object on the slide to 
the “highest”.  

• Because objects automatically appear “on top” when they are inserted, the 
default tab order is from the first object inserted to the last. However, this will 
change if you use features such as “bring to front” and “send to back”.  

• The slide’s main heading should be first in the tab order. 
• Headings should be placed in the tab order immediately before the items (text, 

diagrams, etc.) for which they are acting as a heading. 
• Labels should be in the reading order placed immediately before the objects that 

they label. 
• For simple slide layouts, it may be possible to simply insert objects in a logical 

tab order. 
• For more complex layouts, it may be easier to simply to create the slide as usual 

and then set the tab order (see below). 
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To set the tab order using the ‘Selection Pane’ 
1. Go to menu item: Home 
2. In the Drawing section, select Arrange > Selection Pane… 
3. In the Selection and Visibility pane, all the elements on the slide are listed in 

reverse chronological order under Shapes on this Slide  
4. Elements can be re-ordered using the Re-order buttons located at the bottom of 

the Selection and Visibility pane 

USE SLIDE NOTES 
A useful aspect of presentation applications is the facility to add notes to slides, which 
can then be read by assistive technologies.  You can use these slide notes to explain 
and expand on the contents of your slides in text format.  Slide notes can be created as 
you build your presentation. 

To add notes to your slides 
1. Go to menu item: View 
2. In the Presentation Views section, select Normal to ensure that the notes panel 

is in view 
Note: You can then select menu item Home, to access text formatting options 

3. The Notes Pane can be found at the bottom of the window, below the slide 
4. Type and format your notes within the Notes Pane below each slide 

 
 

Put a unique title on every slide. Since PowerPoint does not provide a document 
heading structure, people using screen readers will use the slide titles when looking for 
a specific page in the slideshow. If duplicate slide titles are found on multiple slides, it 
will be much harder to locate a specific slide.



27 
 

MOTION, BLINKING, TRANSITIONS AND ANIMATIONS 
 
A common accessibility issue concerns moving or blinking content.  Blinking or flashing 
elements can cause seizures in some people. Do not use any element that flashes, 
blinks or has a repetitive motion that repeats faster than 3 times per second.  Even 
people who are not susceptible to seizures are often distracted by these types of 
content, so it is better to just avoid them altogether. 
 
Slide transitions are effects used to move from one slide to the next, for example, slowly 
fading away from one slide while the next slide slowly appears. An example of an 
animation is when you have bullet points appear one at a time on a page, until the entire 
slide is displayed. 
 
If used sparingly, transition and animation effects can be useful during a live 
presentation. However, they should be removed if you distribute the presentation as a 
resource for people to review after the presentation. Screen readers do not work well 
with transitions, and they can be distracting and confusing for people who are reviewing 
the presentation. 

 
MULTIMEDIA AND FIGURES 
 
If you include multimedia content, such as audio or video, in your presentation, you will 
need to make it accessible. 

• Video content must have closed captions 
• Audio content must have a transcript 
• You may find it easier to remove the audio and video from the PowerPoint 

presentation and provide those elements in different formats. 
 

SHAPES 
PowerPoint also allows you to add shapes to a page. The Insert Shapes dialog has a 
number of geometric shapes, arrows, equation signs and more that you can add to a 
page. Some of the shapes, like the speech bubbles, allow you to type text into them, 
while other shapes, like the arrows, do not. But all shapes allow you to add alt text by 
right clicking on the shape and opening the Format Shape option.  
 
A screen reader will treat shapes much the same as it will other content on the slide. In 
other words, you need to add alt text to the shape if you want the screen reader to 
announce any information about the shape itself. Also, when you insert a shape on a 
page, it goes to the end of the reading order. In order for it to make sense, you may 
need to adjust the reading order for the entire slide.  
 
Consider testing the slide with a screen reader to see if it makes sense. If you are 
creating a complex chart using shapes, you may need to provide a text description for 
the entire page, as we did in our discussion of complex chart images. 
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MICROSOFT EXCEL 
 
To make an Excel spreadsheet accessible, we want to do many things that are good 
practice anyway, and some specific things for visually impaired users, such as those 
using assistive technology screen readers. 
 

COMMON-SENSE PRACTICES IN EXCEL  
These practices not only make sense for all spreadsheets, they also help make your 
spreadsheets more accessible at the same time. 
 

Worksheet Names and Table Titles 
Provide descriptive titles in the worksheet name tab and for each table.  

• To change the name of a worksheet, double-click on the tab name and type in a 
new name.  Worksheet names can only have 31 characters. There are also 
some characters it will not accept, including backslash and brackets. 

 

• Give your table a descriptive name that explains what information it contains.  
For example, instead of the title, “Project Plan,” use a title that will tell the reader 
five years from now what the table is about, such as, “Office 2010 Accessibility 
Training Module Timeline, Summer 2012.”  It’s fine if the title takes more than 
one row.  It’s also OK if you would like to merge cells to center your title. 
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• Here’s how to merge cells: 

• Start by putting all your titles in the first column (this helps the screen reader 
find them easily).  

• Next, select the cells you want to merge, then right-click and choose Format 
Cells.  The Format Cells dialog box opens up.   

• Then, choose the Alignment tab, and check the Merge cells box.  
• Finally, in the Horizontal text alignment box, choose Center (assuming you 

want your title centered), then choose OK.   

Row and Column Headers 
Each table should have row and column headers for every column and every row in a 
way that makes sense.  Don’t leave any headers blank, even if the meaning seems 
obvious to you.  

 

No Blank Data Cells 
Cells should not be left blank either. If the cell really has no data, then you can put in:  
“This cell intentionally left blank” or “No data.”  This could be in normal text, or change 
the text color to match the background so only screen readers will read it. 
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Remove Comments 
Remove extraneous comments before publishing (such as those you used when peer-
reviewing).  Screen readers can’t read these, so if that information is important to your 
audience, copy it out of the comments and put it in a cell.  

 
 
 

Set 

Print Area 
Ensure the print area is set correctly. 
 

 
 

• Highlight the entire area of the table including titles and other information 

• In the Ribbon, select the Page Layout tab. 

• In the Page Setup group, select Print Area, and Set Print Area. 

Hide Unused Rows and Columns 
Hide extra rows and columns that are outside the print area. This makes the worksheet 
look less cluttered and prevents screen reader-users and keyboard navigators from 
wasting time wandering off into a trackless waste of blank cells. 
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To hide columns: 
• To begin, select the first column you want to hide. Now, while holding down the 

Shift key, press and release the End key on your keyboard.  Still holding down 
the Shift, now choose the right arrow key.  This selects all columns from the 
first one you selected all the way to the right end of the spreadsheet. 

• Now, with your cursor hovering in the selected area, right-click and choose Hide. 
To hide rows: 

• To hide unused rows below your data, follow a similar procedure.  Leave one 
blank row below your data, then select the first row you want to hide. Hold Shift 
as you press and release End and then press and release the down arrow key. 
Right-click and choose Hide. 

If you need to unhide these cells later follow these steps: 
• First, select the last visible column. 

• Next, hover just to the right of the right edge of the column header.  Your cursor 
should turn from a single cursor with arrows into a double cursor with arrows.  
Click and drag to the right, exposing the very last column. 

• Now select the new, final column, and right-click and choose Unhide. 

Delete Unused Worksheets 
Delete unused worksheets. Right-click on the tab of the unused worksheet and choose 
Delete. Using the keyboard, press Alt, H, D, S.  
 
 

 

Confirm by selecting Delete in the dialog box that pops up.  Be careful, because this 
cannot be undone.   

Check Spelling 
Be sure to do a spell-check. Unlike Word, Excel doesn’t automatically put a squiggly red 
line under any word it thinks is misspelled. 
 

 
 

• In the Review tab, choose Spelling in the Proofing group.  Follow the prompts. 
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• Also, Excel will only spell-check one worksheet at a time, not the whole 
workbook. 

Document Properties 
Fill out the Document Properties to assist all people in finding your document if it gets 
put on a website. 
 
Click the File tab, and choose the Info tab seen on the left.  On the right side there is a 
frame containing the properties. You may insert your properties directly here, or access 
the traditional document properties by clicking the word Properties and choosing Show 
Document Panel.  Either way works.  

 

Here is a screenshot of the document panel: 
 

 
When completing the document panel: 

• For author, follow your agency’s practices. For external publication, some 
agencies suggest putting the agency name instead of the person’s name. 

• Choose keywords that fit the subject matter, such as the name of your division 
and the year.   

• Whatever you put as the subject should probably also be in the keywords or tags.   

• In status, you might put Draft or Final. Don’t forget to change that if the status 
changes! 

• Close the document properties by clicking on the X in the top right corner. 

• Don’t forget to save your document! 
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SCREEN READER HELP TEXT IN CELL A1 
Provide help text for navigation using screen readers, in cell A1. 

• For example, “Press TAB to move to input areas. Press UP or DOWN ARROW in 
column A to read through the document.” 

• You can make this text fairly small, or even change the color to match the 
background color.  This way it will not show up visually, but will still be read by 

the screen reader. 

Table Titles 
Table titles should be placed in the first column so screen readers can find them easily, 
as discussed in the previous module.   

 
 
If that looks funny you can merge cells and center them, but keep the original text in the 
first column. 
 

Avoid Blank Rows and Columns 
Avoid blank rows and columns within a table.   

• Resize your rows and columns to give the spacing that helps make the table 
readable rather than using blanks to create your spacing.   
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• One really common mistake is leaving column A blank (because it makes it look 
like a margin).  

• Also, if you have two or more tables on the same worksheet, leave a single 
blank row between each table.  You can resize the blank row to create a space 
that is visually appealing. 

Merged Cells 
• It’s OK to have merged cells in titles but not in the data part of the table. 

End of Worksheet 
• Type End of Worksheet in the row immediately after the last row of your table.  
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DEFINING THE TITLE REGION – A VERY IMPORTANT STEP 
One final, advanced step is “defining the Title Region” which is a little bit of code so the 
screen reader knows to repeat the row and column titles when reading the data.  We’ll 
walk you through that. 
 
First, a little about how a screen reader reads a table: the default for a screen reader in 
English is to read starting at the top, and going left to right.  When it gets to the end of a 
line, it goes to the next line down and reads, again, from left to right. 
 
Now imagine a screen reader reading this table [example defining title region.xlsx].  
Without some help from you, the screen reader reads it like a book.  After the title, it will 
read, “Type, January, February, March, April, etc.  Then it will go to the next line and 
read Sci Fi 4, 3, 3, 2, 5, 6, and so on.  As sighted readers, we are constantly referring 
back to the row and column headers to see what the numbers refer to.  Visually 
impaired users need those references too. 
 
What we need is for the screen reader to read this way:  

• Sci Fi: January, 4;  

• February, 3;  

• March, 3;  

• And so on.   
In other words, the screen reader should repeat the column header each time before it 
reads the value.  The good news is that screen readers are smart enough to do that!  
We just have to tell them how our table is set up and how to read it.  In our example, 
we’ll just use a standard table with several columns and several rows. 

Here’s how to do it: 
1. Before we get going, we need to know three things about our table:  

• Is this the first (or only) table on this worksheet? 

• What are the addresses of the top left and bottom right cells in your table? 

• Is this worksheet the first (or only) worksheet in this workbook? 
2. To get started, select the top-left cell in your table.  Don’t count the titles, but you 

do count all row and column headers as part of your table. 
3. Go to the Formulas tab in the Ribbon, and choose Name Manager in the 

Defined Names group.  Choose New in the top left corner. A new dialog box 
opens.  In the Name field, we are going to type a fairly complicated name.   
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4. Type TitleRegion then put a 1 if this is the first table on your worksheet; then a 
period; then the range of cells in your table from top left to bottom right (with a 
period in between); then another period; then the worksheet number. So in this 
case our Title code looks like this: 

• TitleRegion1.a2.g7.2 
You can ignore all other fields in this dialog box.  Click OK and Close.  

 
5. That’s it!  You’ve just given JAWS the instructions for how to properly read the 

table so the listener can easily understand it. 
6. By the way, if your table only has one column header, define a 

ColumnTitleRegion instead of a TitleRegion.  If your table only has one row 
header, define a RowTitleRegion.  The rest of the coding is the same. 

7. Finally, if you create these titles and then make a simple change, such as moving 
your worksheet tabs around or adding an extra row, you’ll have to recode the 
titles to match your spreadsheet’s new reality.  So save this step for when you 
are ready to publish. 

8. If you do need to edit these names, go back to the Name Manager, select the 
name you wish to edit, and choose the Edit button.  
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 SAVING YOUR DOCUMENT AS A .PDF 
For staff who do not have access to Adobe Professional, there is an alternate way to 
save your document to ensure the accessibility features are retained. 

 
1. File 
2. Save as 
3. Select PDF from drop down list 
4. Select Options 
5. Ensure “Document structure tag for accessibility” is checked 
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ADOBE 
 

In the Adobe Acrobat X Pro workflow, all PDF documents start with a source document 
created in an office document authoring application, such as Microsoft Word. Because 
source documents provide the starting-point for the PDF documents, accessibility is 
critical. 
 
See above techniques in order to create an accessible source document using 
Microsoft Office. 
For additional information, please contact the Accessibility Coordinator for direction. 

TEST FOR ACCESSIBILITY COMPLIANCE 
The best way to test the accessibility of a document is to attempt to use the document 
with the tools that your readers will use.  However, even if you don’t have a screen 
reader or other assistive device, you can use any of the following methods provided by 
Acrobat 10 Pro for checking the accessibility of a PDF. 

TAGS 
Creating a tagged document directly from an authoring application is the best way to 
make PDFs accessible.  However, if a PDF was created without tags, you can add 
them, using Add Tags to Document.  Often Acrobat tags PDFs when you create them.  

RUN ACCESSIBILITY CHECKS 
For a more thorough review of the accessibility compliance of a document, use one of 
the accessibility check features available in Acrobat 10 Pro.  The Accessibility Quick 
Check examines the PDF to see if it has searchable text, document structure tags, and 
appropriate security settings to make it accessible.  To check for other types of 
accessibility problems, it is best to use the Accessibility Full Check. 
 

LOGICAL READING ORDER 
The order in which elements in a document are read by assistive software is determined 
by the reading order.  Each section of page content appears as a separate highlighted 
region and is numbered according to its placment in the reading order.  You can change 
the reading order of the highlighted regions without changing the actual appearance of 
the PDF.  For example, by reordering highlighted regions on the page, you can make a 
figure and caption read at the specific point that they are referenced in the text without 
actually moving the elements on the page. 
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CHECKING FOR ACCESSIBILITY 
 
It is important to remember that creating tagged PDF documents is only one aspect of 
PDF accessibility.  No matter which authoring application is used to add 
accessibility features and create a PDF document, the following should also 
be performed in Adobe Professional to improve accessibility: 
 

• Tag the document (if it is not already completed) 
• Perform an accessibility Full Check 
• Fix any reading order problems with the TouchUp Reading 

Order tool 
• Add additional accessibility features (set document language). 

 
The accessibility Full Check will provide a detailed report of the accessibility 
problems within the document.  Each type of error detected by the checker 
may require adjustments to one of the following: 
 

• Adjustments to the conversion settings: the conversion 
settings in PDF Maker must be set correctly prior to 
conversion to enhance accessibility.   

• Repairs to the Source File: Repairs made directly to the PDF 
file will be erased in subsequent PDF documents created from 
the same source file; therefore, it is recommended that all 
repairs/revisions are made to the source document and 
converted to PDF.  

• Repairs to the PDF File: a few repairs must be completed to 
the PDF file to improve accessibility.  This includes setting the 
document language, ensuring tab order is consistent with 
structure order and establishing headings for tables. 

 
Continue to check the document until there are no more accessibility issues 
to report.  
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DOCUMENT STRUCTURE TAGS 
 
PDF tags are a mechanism for indicating the organizational structure of documents 
(e.g., headings, paragraphs, sections, tables, and other page elements) without 
changing the visual appearance of the PDF.  These tags enable use with assistive 
devices, such as screen readers, indicate the document reading order and also enable 
mobile devices to reflow and display the document on a small screen. 
 
An untagged document does not have structural information, and Acrobat must infer a 
structure. This situation often results in page items being read in the wrong order or not 
at all.  For best results, tag the document when converting it to PDF from the authoring 
application. 

To add tags automatically 
1. Go to menu 

item: Advanced > 
Accessibility > Add 
Tags To Document 

2. Note: This command 
removes any tags that 
were in the document 
before the command 
was run.  If any 
potential problems 
were encountered, an 
Add Tags Report 
appears in the 
navigation pane. 

 
The automatic tagging feature is 
usually sufficient for most standard 
layouts, but it sometimes cannot 
correctly interpret the structure and reading order of complex page elements (e.g. 
closely spaced columns, irregular text alignment, and tables without borders.).   
If testing (see Technique 2) reveals problems, it is necessary to edit and add tags 
manually using the following techniques. 

To add tags manually 
1. Using the TouchUp Reading Order tool, drag within the document pane to 

select a region of the page that contains one type of content (e.g. a text block) 
2. To add more page content to the current selection, Shift + drag 
3. To remove page content from the current selection, Ctrl + drag 
4. Select the appropriate button in the TouchUp Reading Order dialog to 

specify the tag type 
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READING ORDER 
The order in which elements in a document are read by assistive software is determined 
by the reading order.  Each section of page content appears as a separate highlighted 
region and is numbered according to its placement in the reading order.  You can 
change the reading order of the highlighted regions without changing the actual 
appearance of the PDF.  For example, by reordering highlighted regions on the page, 
you can make a figure and caption read at the specific point that they are referenced in 
the text without actually moving the elements on the page. 

WHEN TO USE THE TOUCHUP READING ORDER TOOL 
The TouchUp Reading Order Tool provides a quick and easy way of fixing reading order 
and tagging problems in a PDF document.  The TouchUp Reading Order Tool can be 
used for the following: 
 

1. Check and repair reading 
order of content 

2. Tag interactive form 
fields 

3. Add alternative text to 
figures/images 

4. Add alternative 
descriptions to form 
fields 

5. Fix tagging of basic 
tables; and 

6. Eliminate nonessential 
content from the tag tree 
(ornamental page 
borders) 
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The TouchUp Reading Order Tool provides the following 
options to users as part of the dialogue box: 

• Show page content order: Page elements are shown 
as highlighted numbered regions.  The reading order of 
the document is associated with the sequence of the 
numbers on the highlighted regions. 

• Show Table Cells: The content of individual cells are 
shown in highlighted regions. This option allows the user 
to view any rows and/or columns that have been 
incorrectly merged/split. 

• Show Tables and Figures: Each table and figure in the 
document is outlined with a crossed-out box.  This option 
allows the user to view the boundaries of a table and 
shows the alternative text for each figure. 

• Clear Page Structure: Tags from all visible pages will be 
removed.  This option can be used if a page contains too 
many tagging problems and the user wishes to start 
again. 

• Show Order Panel: Selecting this option opens the 
Order Panel in the navigation pane. The order Panel can 
assist users with restricting and the reading order of the 
document. 

• Table Editor:  By selecting this option, selected text will be automatically 
analyzed into cells with applicable tags.  Please note that in order to use the 
Table Editor option, the table must be tagged as such. 

• Edit Alternative Text: When a figure is highlighted and the user right-clicks on it, 
the edit alternative text option can be chose.  This option allows users to edit or 
add a text description to a figure. 

• Edit Form Field Text: When a user right-clicks on a form field, the edit form field 
text option can be chosen.  This option allows users to edit or add a text 
description to a form field.  

• Edit Table Summary: When user right-clicks on a highlighted table, the edit 
table summary option can be chosen.  This option allows users to edit or add a 
text description in regards to the table properties. 
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DOCUMENT LANGUAGE 
In order for assistive technologies (e.g., screen readers) to be able to present your 
document accurately, it is important to indicate the natural language of the document.  If 
a different natural language is used for a paragraph or selected text, this also needs to 
be clearly indicated. 

To change the default language 
1. Go to menu item: File > Properties 
2. Select the Advanced tab 
3. In the Reading Options section, select the language from the Language drop-

down list 
4. Select OK 

To apply a language directly to selected element 
1. Go to menu item: View > Navigation Panels > Tags 
2. In the Tags tab, select the element 
3. Right-click* the element and select Properties… 
4. In the Tag tab, select the language from the Language drop-down list 
5. Select Close 

DOCUMENT TITLE 
In case the document is ever converted into HTML, it should be given a descriptive and 
meaningful title.  

To change the title of the current document 
1. Go to menu item: File > Properties 
2. Select the Description tab 
3. Enter a descriptive title in the Title box.  It is also helpful to enter descriptive 

information in the text boxes that follow (Author, Subject, Keywords or 
select Additional Metadata) 

4. Select OK 
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SCANNED DOCUMENTS 
 
Scanned documents are particularly difficult for assistive technology.  They appear as 
an image. Assistive Technology does not read images unless there accompanied by “alt 
text”.  Because a scanned document may be several pages long, it is impossible to 
provide adequate “alt text”.  It is important to ensure that you are always starting with a 
source document that is not scanned. 
 
If you have a scanned document and do not have access to the original source 
document, in order to make the document accessible, you must run it through Optical 
Character Recognition (OCR).This feature can be found in all Professional versions of 
Adobe. 
 
OCR will force Adobe to recognize the text.  Once OCR has been run, you can 
manually add tags and alter the reading order. 
 
On occasion, the OCR tool cannot recognize all of the text within a document.  The tool, 
however, gives the user the ability to examine, confirm and correct questionable text in 
the document. 
 

SEARCHABLE TEXT 
 
Searchable text is an essential characteristic of an accessible PDF document. Assistive 
technology devices, such as screen readers, require documents to have searchable text 
to allow text to be converted into speech.  A document that has been scanned creates a 
graphic representation of the content which prevents the text from being searchable; 
therefore, making scanned images inherently inaccessible.  Users of screen readers 
cannot select or edit the text of a PDF document that is essentially a scanned image. 
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INTRODUCTION



This document was created using the Accessible Digital Office Document (ADOD) Project and resources developed by the Office of the Governor Rick Perry, the State of Texas.



The ADOD Project was developed by the Inclusive Design Research Centre, and OCAD University as part of an Enabling Change Partnership project.



The purpose of this document is to ensure that County of Elgin public documents are created in a way that allows them to be viewed by assistive devices. 



This is a training manual and reference document for staff. 



The software described in this manual includes:



· Microsoft Office 2010 and;

· Adobe Acrobat Professional Version 10 (X)



Sighted people can look at a printed page and easily discern the difference between titles, subtitles, columns of text, headers, footers, and so on. Visual cues, such as location of the text on the page, bold text, and large font sizes help them determine the structure of a document so they can read and navigate it easily.



Unfortunately, assistive technologies such as screen readers can’t depend on these visual cues. They must instead rely on the underlying computer-based information to provide that same structure.



Disclaimer



Following these techniques will increase the accessibility of your documents, but it does not guarantee accessibility to any specific disability groups.  In cases where more certainty is required, it is recommended that you test the office documents with end users with disabilities, including screen reader users.


GENERAL



TIPS and Best practices



The following rules can be applied to most documents created in Microsoft Word, Excel and PowerPoint:

· Design the source document with accessibility in mind;

· Use program styles available in the application rather than character formatting for headings;

· Add alternative text to all graphics and images;

· Create the PDF in a manner that generates tags;

· Check the accessibility of a document using the Accessibility Check in Office or, after conversion using the Full Check feature in Adobe Acrobat Professional (available in both version X or XI)

· When adding accessibility features to a document they should always be added to the source document first (if possible) as it is often faster and easier.



STYLE GUIDELINES

When formatting text, especially when the text is likely to printed, try to:

· Use font sizes between 12 and 14 points for body text.

· Use fonts of normal weight, rather than bold or light weight fonts.  If you do choose to use bold fonts for emphasis, use them sparingly. 

· Use standard fonts with clear spacing and easily recognized upper and lower case characters. Sans serif fonts (e.g., Arial, Verdana) may sometimes be easier to read than serif fonts (e.g., Times New Roman, Garamond).

· Avoid large amounts of text set all in caps, italic or underlined.

· Do not condense or stretch lines of text. It is recommended that text align to the left margin as it is easy to find the start of the next line, and keeps the spaces even between words. (“Ragged Right” is the best approach)

· Use bullets and numbering to create lists and outlines

· Choose a sharp colour contrast for all elements of a document

· Avoid using text boxes

· Set font colour to “automatic” or “black”

· Use heading styles to control line spacing rather than the enter key

· Place white space between text and graphics/images

· Do not use watermarks or backgrounds



By taking the time to design your content in a consistent way, it will be easier to access, navigate and interpret for all users:

· Whenever possible, write clearly with short sentences.

· Introduce acronyms and spell out abbreviations.

· Avoid making the document too “busy” by using lots of whitespace and by avoiding too many different colors, fonts and images.

· If content is repeated on multiple pages within a document or within a set of documents (e.g., headings, footings, etc.), it should occur consistently each time it is repeated.  

· Ensure text for links is descriptive (e.g. don’t use “click here”) 



*This general section of this document provides techniques that can be used in any of the Microsoft Office programs.  

Check Accessibility



The accessibility checker assists with finding accessibility errors in Word, PowerPoint and Excel.

Although the checker can find a variety of issues, it cannot find every possible error. If you get a clean bill from the accessibility checker, you still need to follow the rules for creating accessible Office files.



*Note – in order to use the accessibility checker, your file must be saved as a .docx



The “Accessibility Checker” classifies issues as

· Error – content that makes a file very difficult or impossible for people with disabilities to understand

· Warning – content that in most, but not all, cases makes a file difficult for people with disabilities to understand

· Tip – content that people with disabilities can understand, but that might be better organized or presented in a way that would maximize their experience



1. To use the “Accessibility Checker”

2. Go to menu item: File 

3. Select Info in the left window pane

4. Under Prepare for Sharing, an alert will appear if a potential accessibility issue has been detected
To view and repair the issues, select Check for Issues and then Check Accessibility

1. An Accessibility Checker task pane will open, showing the inspection results 

2. Select a specific issue to see Additional Information 

3. Follow the steps provided to fix or revise the content



The task pane is divided into two sections: Inspection Results and Additional Information. 

The Inspection Results section shows the list of accessibility issues found in the document.  If you click on the issue, the Additional Information section gives you details on why this is a problem and tips on how to fix it.



You should correct all of the issues listed, if possible.  If you have any questions, ask your Municipal Accessibility Specialist.



Now that the checker has given you a list of issues, what do you do?

Let’s look at an error listed by the checker.  

Notice that the issues are listed in categories.  The first category in our list is Missing Alt Text.  Alt text must be provided for any element that cannot be fully described by a screen reader.  In this example, there are 11 pictures that are missing Alt Text.



To find the error in the document, click on an element in the error list.  Word will move to the place in the document where the error was found.  By clicking on Picture 2, the picture moves to the top of the window. 



If you are unsure how to fix the error, remember that the checker also provides more information.  If the Additional Information area is not visible, click on the up-arrow character next to the Additional Information heading at the bottom of the task pane.  The additional information not only explains why the problem should be fixed, but how to fix it.




Colour Contrast

Appropriate colors and contrast are necessary for people to see our words and understand their meaning. This is especially true for people who are colorblind or have other visual disabilities.



We create documents to communicate. We invest our time organizing our thoughts and carefully choosing our words so we can deliver a clear, concise message. If we then put it all down in a way people cannot read or understand, we have not done our best at communicating.



There are two very simple rules when it comes to color and contrast in our documents:

Rule 1: Do not ask your reader to make a choice based on color alone

If color is used as the only visual means of conveying a message, asking for a response, or identifying a visual element, then what is a person who is colorblind to do?



Let’s suppose for a moment that you are asking your reader to make a choice based on color. Your closing line may go something like, “If you want to generously donate your next paycheck to my favorite charity, sign in the green box. If you prefer to donate the five dollar minimum, sign in the red box.” 

Where should the colorblind reader sign? Most likely, they won’t sign at all.

If you do choose to add color or shading to your document, make sure that the information conveyed in color is also available without color. In the prior example, you might add the appropriate text to the two boxes just to be sure the message is clear.


Rule 2: Use sufficient contrast

A recent design trend involves presenting grey text in small, sans serif fonts on a white background.  People with visual disabilities, including those with aging eyes, cannot read this. In fact, even people with perfectly good eyesight have some problems with this.



In most cases, it is enough to say we must use sufficiently contrasting foreground and background colors. But, for those who want a more exacting definition, here is some help.

Text should have a minimum contrast ratio of 4.5 to 1. This is the minimum ratio, not the recommended one.  



Updated: August 18, 2014
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Avoid Using Images of Text



Before you use an image to control the presentation of text (e.g. to ensure a certain font or colour combination), consider whether you can achieve the same result by styling “real text”.



If this is not possible, as with logos containing stylized text, make sure to provide alternative text for the image following the techniques noted above.



Logos using the corporations name are acceptable in most cases; however, try to limit the information to only the corporation’s name. 


Write Clearly



By taking the time to design your content in a consistent way, it will be easier to access, navigate and interpret for all users.



· Whenever possible, write clearly with short sentences.

· Introduce acronyms and spell out abbreviations. 

· Avoid making the document too “busy” by using lots of whitespace and by avoiding too many different colours, fonts and images.

To turn on Readability Statistics 



· Select the Office Button

· Select Word Options

· Select Proofing

· Ensure Show Readability Statistics box is checked




To check your grade level



1. Select the Review tab

2. Select Spelling and Grammar

3. When spell check is complete, your grade level will pop up in a dialogue box.

Reading Ease

· Paragraphs with a high “reading ease” tend to be easier to read.

· Scores 0 – 100

· Plain English = 65

Grade Level

· Paragraphs with a lower “grade level” tend to be easier to read.

 


Document Properties



In case the document is ever converted into HTML, it should be given a descriptive and meaningful title. 

To change the title of the current document

1. Go to menu item: File> Info > Properties

2. In the Document Properties section that appears, select the Title text box

3. Enter the Title
Note: The Title defined in the properties is different than the file name.

 

Templates

All office documents start with a template, which can be as simple as a blank standard-sized page or as complex as a nearly complete document with text, graphics and other content. For example, a “Meeting Minutes” template might include headings for information relevant to a business meeting.



Because templates provide the starting-point for so many documents, accessibility is critical. If you are unsure whether a template is accessible, you should check a sample document produced when the template is used.

 

It is possible to create your own accessible templates from scratch in Office 2010.  As well, you can edit and modify the existing pre-packaged templates, ensuring their accessibility as you do so and saving them as a new template.

To create an accessible template

1. Create a new document (from the default blank template or from one of the pre-packaged templates)

2. Ensure that you follow the techniques in this document

3. When you are finished you should also check the accessibility of the document (See Technique 10, below)

4. Go to menu item: Office > Save As > Word Template

5. Save the template in the Microsoft > Templates folder

6. In the File name box, type a name for the template.  Using a descriptive File name (e.g., “Accessible Memo Template”) may increase the prominence of the accessibility status.  As well, filling in the text box labelled Tags with the term “accessibility” may improve its searchability as an accessible file.

7. Select Save

To select an accessible template

1. Go to menu item: Office > New

2. Under Templates, select My templates…

3. In the New document dialog, select your accessible template from the list in the My Templates tab

4. Select OK

5. A new document based on the template will be displayed. If you have chosen an accessible template, the document will be accessible at this point. As you add your content (e.g., text, images, etc.), ensure that you consult the sections that follow to preserve accessibility.


HYPERlinks

Use Meaningful Link Text

Modern screen readers are able to make a list of all the links inside a document. This helps the user quickly find the link they are looking for. If the link text is meaningful, the right link is easily found.



All too often, we see links in a document with the text “Click Here”. If the author writes “Click Here” for all links, guess what the screen reader will say? That’s right, a tiresome refrain of “Click Here, Click Here, Click Here.” 



When we link with words like “Click Here” or “Read More,” we aren’t giving the user any useful information about that link. And that’s not accessible. 



To make the links accessible, use contextual links, or links made of meaningful words that describe the hyperlink. Use concise and descriptive text and not the actual hyperlink address or URL. In fact, the Word Accessibility Checker will flag URLs as unclear text. 



To make a hyperlink, follow these five simple steps:

· First, select the meaningful text that will be used for the link.

· Then, click on Hyperlink in the Insert ribbon.

· Next, select the appropriate Link to choice on the left side of the Insert Hyperlink dialog box. You can also verify your text selection at the top of the box.

· Now, add the complete URL in the Address field at the bottom and click OK.

· Finally, check that your link goes to the proper location.

· If linking to internal documents, make sure the document will only be used on internal server systems. 


MICROSOFT WORD

Styles

You should attempt to make use of the named styles that are included in Microsoft Office.  Styles make a document easier to navigate for users of assistive technology.



Word includes a number of built-in styles that are always available, some of which are key to using different Word features. For example, Normal style is the default paragraph style for all text in your Word document. 



Normal is the style on which most other paragraph styles are based. That means if you change Normal style (such as changing the font style or size), many other styles will automatically change to match. As you can imagine, this kind of link between styles can be incredibly useful. It can also be incredibly frustrating if used incorrectly.



Perhaps the most dynamic of the built-in styles are the paragraph styles Heading 1 through Heading 9.  Styles can be found by clicking on the “Home” tab.



There are two types of styles:



· Paragraph Styles (also known as block styles) are identified by the paragraph symbol after the style name.  To apply a paragraph style, place your cursor anywhere in the paragraph in front of the paragraph marker, and click the style name.

· Character Style are identified by the lower-case “a” after the style name. To apply a character style, highlight the desired text, then click on the style name.



When applying styles, remember that the last applied style determines the formatting. Also, when you apply a character style over a paragraph style, the character style will be dominant.


Headings



Documents that are longer than a few paragraphs require structuring to make them easier for readers to understand.  The easiest way to do this is to use “Headings”.  Headings create logical divisions between paragraphs.  Headings are structural elements that provide a meaningful sequence to users of assistive technologies.



Headings can be found under “Styles” in the Home Ribbon in Microsoft Word.



Headings orient a user to a particular section or element.



It is important that you use the numerical order of headings within your document.  You can only have one Heading1; followed by Heading2 etc.  You can have multiple Heading2 or Heading3.

To modify a style/heading:

1. Right click on the style

2. Select Modify

3. In the Modify Style dialog make the appropriate changes to the style

4. Select OK





To apply a heading:

1. Highlight the text you wish to apply the heading to.

2. Select the appropriate heading from the Styles List.


Alternate Text (Alt Text)

When using images or other graphical objects, such as charts, tables and graphs, it is important to ensure that the information you intend to convey by the image is also conveyed to people who cannot see the image.  This can be done by adding alternative text to each image.  If an image is too complicated to concisely describe in the alternative text alone (flowcharts, etc.), you should provide a short text alternative and longer description as well.

To add alternative text to images, tables and graphical objects



1. Right click the object

2. Select Format Picture, Table Properties or Size

3. Select the Alt Text tab in the Size dialog

4. Fill in the Alterative Text under Description (leave the “Title” blank)

5. Close







If your document originated in an earlier version of Word, it will open in the Compatibility Mode and the process will be slightly different. When the Alt Text dialog box opens, select the Alt Text tab, then enter a brief description in the alt text field. 


Is a Picture Really Worth a Thousand Words?



Sometimes figures are extremely important to the content of a document.  They provide nonverbal information to readers. As the document author, you must decide whether a picture contains information that will be useful to the reader of the document.



If the information in an image adds meaning to the document, explain the figure succinctly but accurately in the alt text.  However, if an image is there merely for decorative purposes and does not add meaning to the text, type a pair of quotation marks (“”) in the alt text. This lets the reader know that the alt text was not forgotten.



If you add a very complex image, such as a graph or chart, it may not be possible to describe the picture in a few words. If that is the case, it may make sense to repeat the information from the image in that page text that follows the image. Everyone who reads the document can then focus on the important information found in the image, including assistive technology users.  For example, if a graph of quarterly earnings is followed by a paragraph that describes the earnings report, then the alt text for the image might just say “quarterly earnings, details to follow in page text”. 

Tips for writing alternative text

· Try to answer the question “what information is the image conveying?”

· If the image does not convey any useful information, think about not using the image at all.

· If the image contains meaningful text, ensure all of the text is replicated

· Alternative text should be fairly short, usually a sentence or less. (rule of thumb 40-60 characters)

· If more description is required, provide a short description in the alternative text and more detail in the long description

· Test by having others review the document with images replaced by the alternative text



Long Descriptions

Long descriptions should be use when text alternatives are insufficient to answer the question “what information is the image conveying?”.

· In some situations, the information being conveyed will be how an image looks.  In these cases, try to describe the image without making too many of your own assumptions.

· One approach is to imagine you are describing the image to a person over the phone.

· Ensure that you provide a concise alternative text to help readers decide if they are interested in the longer description.



Long descriptions can be used in place of alt text and used when more information is required to explain a chart or graph.


Lists



When you create lists, it is important to format them as “real lists”.  Otherwise, assistive technologies will interpret your list as a series of short separate paragraphs instead of a coherent list of related items. 



You can apply the list style before or after you type the list.  If you choose to type first, highlight the list when you are done and click on the style of your choice.

To create an ordered or unordered list

1. Go to menu item: Home

2. In the Paragraph section, select the Bullets icon for unordered list or select the Numbering icon for ordered lists

3. To choose a different list format, select the arrow beside the icon

4. Select a format from the format Library that appears in the drop-down menu.



Page Breaks



The Page Break feature is very important for assistive technology.  Whenever you need to start a new page, select the Page Break feature instead of repeated hard returns (enter key).



Page Breaks can be found under the Insert tab, or for other types of Breaks, click on the Page Layout tab and choose the down arrow beside Breaks.




Table of Contents



Creating an index or table of contents to outline office documents can provide a means of navigating the content in a meaningful sequence. 



The best way to generate a table of contents is after applying the predefined heading styles, such as “Heading1” to the headings that you want to include in your table of contents.  After you apply these styles, you can then create a table of contents. 



When headings are organized in a table of contents, the reader can quickly review the information contained in the document.  Like the document navigation map, a table of contents outlines structure and allows for quick navigation.  From the table of contents, you can skip to a certain topic by pressing the control key and clicking on the heading.

To insert a Table of Contents

1. Place the cursor in your document where you want to create the table of contents.

2. Go to menu item: References

3. In the Table of Contents section, select Table of Contents

4. Select the style that you want to use



To update the Table of Contents

1. Select the table

2. Go to menu item: References

3. In the Table of Contents section, select the Update Table button



Select the type of table you would like to insert:

a. Automatic

b. Manual or;

c. “Insert” (this option gives you the ability to control the properties of the table)
If you use a manual table, you must add the title of each item and enter all updates and changes yourself.


Tables



Tables can be great for presenting data, but we need to avoid using tables simply to format other content.

When using tables, it is important to ensure that they are clear and appropriate structured.  This helps all users to better understand the information in the table and allows assistive technologies (e.g. screen readers) to provide context so that the information within the table can be conveyed in a meaningful way.

Tips for tables

· Use “real tables” rather than text formatted to look like tables using the TAB key or space bar.  These will not be recognized by assistive technology.

· Keep tables simple by avoiding merged cells and dividing complex data sets into separate smaller tables, where possible.  Whenever possible, use just one row of headings.

· Create a text summary of the essential table contents.  Any abbreviations should be explained in the summary.

· Table captions or descriptions should answer the question “what is the table’s purpose and how is it organized?”.

· Table cells should be marked as table headers when they serve as labels to help interpret the other cells in the table.

· Table header cell labels should be concise and clear.

· Avoid merging or splitting cells, where possible. 

· Do not control spacing in your table with blank rows or columns. Adjust line spacing instead.

To add a table with headings

1. Go to Insert tab

2. Select the Tables icon

3. Select the number of rows and columns you would like your table to have

4. Select the table and a Table Tools menu item should appear

5. Go to menu item Table Tools >Design

6. In the Table Style Options section, select the Header Row Check box


Setting the Table

Before you insert your table, it’s a good idea to know how many columns and rows you need.  Remember to allow for the column headers.  

The width of your columns should also be given some consideration, so that the table does not exceed the width of the page. For some tables you may need to change the page orientation to landscape to give yourself more room horizontally.



Mind Your Table Manners



· Give your table a title using the Caption tool.  Make sure the label field indicates that this is a caption for a table.

Identify the header row. Here’s how:

1. Select just the top row of your table, right click and choose Table Properties

2. Select the Row tab

3. Check the box labelled Repeat as header row at the top of each page 




Select a table style that sets the text, background and grid colours for the table. When selecting a style, consider the following issues:



· Be sure there is enough contrast between the text and background colours of each cell. 

· Choose a table style that provides grid lines to separate the data cells. If someone is using a screen magnifier to view the table, the grid lines help them follow each row across the page, especially if there is a lot of space between the text in adjacent cells.  The grid lines are also useful for separating cells if there is a lot of text.



Use simple data tables. Never merge two or more cells into a single larger cell or split into smaller cells.  The table should be a simple grid with predictable rows and columns. Complex table structure is nearly impossible to follow with a screen reader.







Provide column headers for your data table. This helps people understand the meaning of each column of data.  Type the column header text into the first row of the table, and be sure to select the Header Row option on the Table Tools Design tab. 



Add alt text to make your table more accessible. To add alt text, right click within the table, select the Format Shape option, and then select Alt Text tab.




Charts

Charts, graphs, and other complex images may contain so much information that it is difficult to sufficiently describe them with Alt Text.



You can approach this problem in several ways.

· First, consider whether it is possible to simplify the chart, or split it into multiple charts, so that each one contains a smaller amount of information. This will not only simplify the alt text required for each chart, but will make the information more understandable for everyone in your audience. 

· If the image is still too complex to describe the alt text, you will need to provide a text description elsewhere. (One possibility is to add the full description to the Notes section if using PowerPoint). If you do this, add alt text to the picture with a very short description of the picture, and end with the words "Full text description in the Notes section of this slide." You can even place that note on the slide itself, so even people who do not use screen readers can find the text description.



· Another possibility for describing a complex picture is to type the description into a text box placeholder on the slide, and then place the picture OVER the text, so that only the picture is visible on the page. The screen reader will announce the hidden text even though it is not visible on the page. 





 

MICROSOFT POWERPOINT

Use Built-In Layout and Styling Features

 PowerPoint 2010 does not offer “True Headings” or “Named Styles” as does Word 2010.

Use Built-In Slide Layouts

Instead of creating each slide in your presentation by starting from a blank slide, check whether there is a suitable built-in layout. 



Note: The built-in layouts can be more accessible to users of assistive technologies because technologies sometimes read the floating items on the slide in the order that they were placed on the slide. The built-in layouts have usually taken this into account (e.g., “Title” first followed by other items, left to right and from top to bottom). If you create slide layouts from scratch, it is sometimes difficult to keep track of the order elements were placed.

To apply “true layout” to a slide

1. Go to menu item: Home

2. In the Slides section, select the Layout button

3. Select the layout you would like to use from the drop down menu










Customize Using Master Slides

If a layout must be customized, it is recommended that Master Slides be used.



Every slide layout in a presentation is defined by its master slide.  A master slide determines the formatting style for various elements of the slide layout.  This includes font styles, character formatting, and the positioning of elements.  Essentially, each master slide acts as a design template for the slide layout.



If you edit any aspect of the slide layout in the master slide, the change will affect all slides that were created based on it.  For this reason, it is good practice to edit the master slide and use the slide layouts before building individual slides.  It is essential that you create and use master slides that meet the accessibility requirements outlined in this document.

To create or customize a master slide

1. Go to menu item: View

2. In the Presentation Views section, select the Slide Master icon

3. The current slide master with its associate layouts appears

Note: If you have the Normal view open, the slide master is the larger slide image in the slide thumbnail pane.  The associated layouts are positioned beneath the slide master.

4. Customize the existing master slide and its associated layouts to suit your needs (e.g., apply a design, theme-based colors, fonts, effects, backgrounds) ensuring that your changes meet accessibility requirements

5. Go to menu item: Office > Save As > Other Formats

6. In the File name box, type a file name

7. In the Save as type list, select PowerPoint template

8. Select Save

9. On the Slide Master tab, in the Close section, select Close Master View








Set a Logical Tab Order

Many presentation applications create content composed almost exclusively of "floating" objects. This means that they avoid the transitions between in-line content and secondary "floating" objects (text boxes, images, etc.) that can cause accessibility issues in word processors. 

However, when you are working with "floating" objects, it is important to remember that the way objects are positioned in two dimensions on the screen may be completely different from how the objects will be read by a screen reader or navigated using a keyboard. The order that content is navigated sequentially is called the "Tab Order" because often the "Tab" key is used to navigate from one "floating" object to the next.

Tips for setting a logical “tab order” for "floating" objects

· The tab order of floating objects is usually from the “lowest” object on the slide to the “highest”. 

· Because objects automatically appear “on top” when they are inserted, the default tab order is from the first object inserted to the last. However, this will change if you use features such as “bring to front” and “send to back”. 

· The slide’s main heading should be first in the tab order.

· Headings should be placed in the tab order immediately before the items (text, diagrams, etc.) for which they are acting as a heading.

· Labels should be in the reading order placed immediately before the objects that they label.

· For simple slide layouts, it may be possible to simply insert objects in a logical tab order.

· For more complex layouts, it may be easier to simply to create the slide as usual and then set the tab order (see below).


To set the tab order using the ‘Selection Pane’

1. Go to menu item: Home

2. In the Drawing section, select Arrange > Selection Pane…

3. In the Selection and Visibility pane, all the elements on the slide are listed in reverse chronological order under Shapes on this Slide 

4. Elements can be re-ordered using the Re-order buttons located at the bottom of the Selection and Visibility pane

Use Slide Notes

A useful aspect of presentation applications is the facility to add notes to slides, which can then be read by assistive technologies.  You can use these slide notes to explain and expand on the contents of your slides in text format.  Slide notes can be created as you build your presentation.

To add notes to your slides

1. Go to menu item: View

2. In the Presentation Views section, select Normal to ensure that the notes panel is in view

Note: You can then select menu item Home, to access text formatting options

3. The Notes Pane can be found at the bottom of the window, below the slide

4. Type and format your notes within the Notes Pane below each slide




Put a unique title on every slide. Since PowerPoint does not provide a document heading structure, people using screen readers will use the slide titles when looking for a specific page in the slideshow. If duplicate slide titles are found on multiple slides, it will be much harder to locate a specific slide.
Motion, Blinking, Transitions and Animations



A common accessibility issue concerns moving or blinking content.  Blinking or flashing elements can cause seizures in some people. Do not use any element that flashes, blinks or has a repetitive motion that repeats faster than 3 times per second.  Even people who are not susceptible to seizures are often distracted by these types of content, so it is better to just avoid them altogether.



Slide transitions are effects used to move from one slide to the next, for example, slowly fading away from one slide while the next slide slowly appears. An example of an animation is when you have bullet points appear one at a time on a page, until the entire slide is displayed.



If used sparingly, transition and animation effects can be useful during a live presentation. However, they should be removed if you distribute the presentation as a resource for people to review after the presentation. Screen readers do not work well with transitions, and they can be distracting and confusing for people who are reviewing the presentation.



Multimedia and Figures



If you include multimedia content, such as audio or video, in your presentation, you will need to make it accessible.

· Video content must have closed captions

· Audio content must have a transcript

· You may find it easier to remove the audio and video from the PowerPoint presentation and provide those elements in different formats.



Shapes

PowerPoint also allows you to add shapes to a page. The Insert Shapes dialog has a number of geometric shapes, arrows, equation signs and more that you can add to a page. Some of the shapes, like the speech bubbles, allow you to type text into them, while other shapes, like the arrows, do not. But all shapes allow you to add alt text by right clicking on the shape and opening the Format Shape option. 



A screen reader will treat shapes much the same as it will other content on the slide. In other words, you need to add alt text to the shape if you want the screen reader to announce any information about the shape itself. Also, when you insert a shape on a page, it goes to the end of the reading order. In order for it to make sense, you may need to adjust the reading order for the entire slide. 



Consider testing the slide with a screen reader to see if it makes sense. If you are creating a complex chart using shapes, you may need to provide a text description for the entire page, as we did in our discussion of complex chart images.


MICROSOFT EXCEL



To make an Excel spreadsheet accessible, we want to do many things that are good practice anyway, and some specific things for visually impaired users, such as those using assistive technology screen readers.



Common-Sense Practices in Excel 

These practices not only make sense for all spreadsheets, they also help make your spreadsheets more accessible at the same time.



Worksheet Names and Table Titles

Provide descriptive titles in the worksheet name tab and for each table. 

· To change the name of a worksheet, double-click on the tab name and type in a new name.  Worksheet names can only have 31 characters. There are also some characters it will not accept, including backslash and brackets.



· Give your table a descriptive name that explains what information it contains.  For example, instead of the title, “Project Plan,” use a title that will tell the reader five years from now what the table is about, such as, “Office 2010 Accessibility Training Module Timeline, Summer 2012.”  It’s fine if the title takes more than one row.  It’s also OK if you would like to merge cells to center your title.



· Here’s how to merge cells:

· Start by putting all your titles in the first column (this helps the screen reader find them easily). 

· Next, select the cells you want to merge, then right-click and choose Format Cells.  The Format Cells dialog box opens up.  

· Then, choose the Alignment tab, and check the Merge cells box. 

· Finally, in the Horizontal text alignment box, choose Center (assuming you want your title centered), then choose OK.  

Row and Column Headers

Each table should have row and column headers for every column and every row in a way that makes sense.  Don’t leave any headers blank, even if the meaning seems obvious to you. 



No Blank Data Cells

Cells should not be left blank either. If the cell really has no data, then you can put in:  “This cell intentionally left blank” or “No data.”  This could be in normal text, or change the text color to match the background so only screen readers will read it.








Remove Comments

Remove extraneous comments before publishing (such as those you used when peer-reviewing).  Screen readers can’t read these, so if that information is important to your audience, copy it out of the comments and put it in a cell. 







Set Print Area

Ensure the print area is set correctly.







· Highlight the entire area of the table including titles and other information

· In the Ribbon, select the Page Layout tab.

· In the Page Setup group, select Print Area, and Set Print Area.

Hide Unused Rows and Columns

Hide extra rows and columns that are outside the print area. This makes the worksheet look less cluttered and prevents screen reader-users and keyboard navigators from wasting time wandering off into a trackless waste of blank cells.






To hide columns:

· To begin, select the first column you want to hide. Now, while holding down the Shift key, press and release the End key on your keyboard.  Still holding down the Shift, now choose the right arrow key.  This selects all columns from the first one you selected all the way to the right end of the spreadsheet.

· Now, with your cursor hovering in the selected area, right-click and choose Hide.

To hide rows:

· To hide unused rows below your data, follow a similar procedure.  Leave one blank row below your data, then select the first row you want to hide. Hold Shift as you press and release End and then press and release the down arrow key. Right-click and choose Hide.

If you need to unhide these cells later follow these steps:

· First, select the last visible column.

· Next, hover just to the right of the right edge of the column header.  Your cursor should turn from a single cursor with arrows into a double cursor with arrows.  Click and drag to the right, exposing the very last column.

· Now select the new, final column, and right-click and choose Unhide.

Delete Unused Worksheets

Delete unused worksheets. Right-click on the tab of the unused worksheet and choose Delete. Using the keyboard, press Alt, H, D, S. 







Confirm by selecting Delete in the dialog box that pops up.  Be careful, because this cannot be undone.  

Check Spelling

Be sure to do a spell-check. Unlike Word, Excel doesn’t automatically put a squiggly red line under any word it thinks is misspelled.







· In the Review tab, choose Spelling in the Proofing group.  Follow the prompts.

· Also, Excel will only spell-check one worksheet at a time, not the whole workbook.

Document Properties

Fill out the Document Properties to assist all people in finding your document if it gets put on a website.



Click the File tab, and choose the Info tab seen on the left.  On the right side there is a frame containing the properties. You may insert your properties directly here, or access the traditional document properties by clicking the word Properties and choosing Show Document Panel.  Either way works. 



Here is a screenshot of the document panel:





When completing the document panel:

· For author, follow your agency’s practices. For external publication, some agencies suggest putting the agency name instead of the person’s name.

· Choose keywords that fit the subject matter, such as the name of your division and the year.  

· Whatever you put as the subject should probably also be in the keywords or tags.  

· In status, you might put Draft or Final. Don’t forget to change that if the status changes!

· Close the document properties by clicking on the X in the top right corner.

· Don’t forget to save your document!


Screen Reader Help Text in Cell A1

Provide help text for navigation using screen readers, in cell A1.

· For example, “Press TAB to move to input areas. Press UP or DOWN ARROW in column A to read through the document.”

· You can make this text fairly small, or even change the color to match the background color.  This way it will not show up visually, but will still be read by the screen reader.

Table Titles

Table titles should be placed in the first column so screen readers can find them easily, as discussed in the previous module.  





If that looks funny you can merge cells and center them, but keep the original text in the first column.



Avoid Blank Rows and Columns

Avoid blank rows and columns within a table.  

· Resize your rows and columns to give the spacing that helps make the table readable rather than using blanks to create your spacing.  

· One really common mistake is leaving column A blank (because it makes it look like a margin). 

· Also, if you have two or more tables on the same worksheet, leave a single blank row between each table.  You can resize the blank row to create a space that is visually appealing.

Merged Cells

· It’s OK to have merged cells in titles but not in the data part of the table.

End of Worksheet

· Type End of Worksheet in the row immediately after the last row of your table. 




Defining the Title Region – a Very Important Step

One final, advanced step is “defining the Title Region” which is a little bit of code so the screen reader knows to repeat the row and column titles when reading the data.  We’ll walk you through that.

First, a little about how a screen reader reads a table: the default for a screen reader in English is to read starting at the top, and going left to right.  When it gets to the end of a line, it goes to the next line down and reads, again, from left to right.

Now imagine a screen reader reading this table [example defining title region.xlsx].  Without some help from you, the screen reader reads it like a book.  After the title, it will read, “Type, January, February, March, April, etc.  Then it will go to the next line and read Sci Fi 4, 3, 3, 2, 5, 6, and so on.  As sighted readers, we are constantly referring back to the row and column headers to see what the numbers refer to.  Visually impaired users need those references too.

What we need is for the screen reader to read this way: 

· Sci Fi: January, 4; 

· February, 3; 

· March, 3; 

· And so on.  

In other words, the screen reader should repeat the column header each time before it reads the value.  The good news is that screen readers are smart enough to do that!  We just have to tell them how our table is set up and how to read it.  In our example, we’ll just use a standard table with several columns and several rows.

Here’s how to do it:

1. Before we get going, we need to know three things about our table: 

· Is this the first (or only) table on this worksheet?

· What are the addresses of the top left and bottom right cells in your table?

· Is this worksheet the first (or only) worksheet in this workbook?

2. To get started, select the top-left cell in your table.  Don’t count the titles, but you do count all row and column headers as part of your table.

3. Go to the Formulas tab in the Ribbon, and choose Name Manager in the Defined Names group.  Choose New in the top left corner. A new dialog box opens.  In the Name field, we are going to type a fairly complicated name.  

4. Type TitleRegion then put a 1 if this is the first table on your worksheet; then a period; then the range of cells in your table from top left to bottom right (with a period in between); then another period; then the worksheet number. So in this case our Title code looks like this:

· TitleRegion1.a2.g7.2

You can ignore all other fields in this dialog box.  Click OK and Close. 



5. That’s it!  You’ve just given JAWS the instructions for how to properly read the table so the listener can easily understand it.

6. By the way, if your table only has one column header, define a ColumnTitleRegion instead of a TitleRegion.  If your table only has one row header, define a RowTitleRegion.  The rest of the coding is the same.

7. Finally, if you create these titles and then make a simple change, such as moving your worksheet tabs around or adding an extra row, you’ll have to recode the titles to match your spreadsheet’s new reality.  So save this step for when you are ready to publish.

8. If you do need to edit these names, go back to the Name Manager, select the name you wish to edit, and choose the Edit button. 


 SAVING YOUR DOCUMENT AS A .PDF

For staff who do not have access to Adobe Professional, there is an alternate way to save your document to ensure the accessibility features are retained.



1. File

2. Save as

3. Select PDF from drop down list

4. Select Options

5. Ensure “Document structure tag for accessibility” is checked


ADOBE



In the Adobe Acrobat X Pro workflow, all PDF documents start with a source document created in an office document authoring application, such as Microsoft Word. Because source documents provide the starting-point for the PDF documents, accessibility is critical.



See above techniques in order to create an accessible source document using Microsoft Office.

For additional information, please contact the Accessibility Coordinator for direction.

Test for Accessibility Compliance

The best way to test the accessibility of a document is to attempt to use the document with the tools that your readers will use.  However, even if you don’t have a screen reader or other assistive device, you can use any of the following methods provided by Acrobat 10 Pro for checking the accessibility of a PDF.

Tags

Creating a tagged document directly from an authoring application is the best way to make PDFs accessible.  However, if a PDF was created without tags, you can add them, using Add Tags to Document.  Often Acrobat tags PDFs when you create them. 

Run Accessibility Checks

For a more thorough review of the accessibility compliance of a document, use one of the accessibility check features available in Acrobat 10 Pro.  The Accessibility Quick Check examines the PDF to see if it has searchable text, document structure tags, and appropriate security settings to make it accessible.  To check for other types of accessibility problems, it is best to use the Accessibility Full Check.



Logical Reading Order

The order in which elements in a document are read by assistive software is determined by the reading order.  Each section of page content appears as a separate highlighted region and is numbered according to its placment in the reading order.  You can change the reading order of the highlighted regions without changing the actual appearance of the PDF.  For example, by reordering highlighted regions on the page, you can make a figure and caption read at the specific point that they are referenced in the text without actually moving the elements on the page.




Checking for Accessibility



It is important to remember that creating tagged PDF documents is only one aspect of PDF accessibility.  No matter which authoring application is used to add accessibility features and create a PDF document, the following should also be performed in Adobe Professional to improve accessibility:



· Tag the document (if it is not already completed)

· Perform an accessibility Full Check

· Fix any reading order problems with the TouchUp Reading Order tool

· Add additional accessibility features (set document language).



The accessibility Full Check will provide a detailed report of the accessibility problems within the document.  Each type of error detected by the checker may require adjustments to one of the following:



· Adjustments to the conversion settings: the conversion settings in PDF Maker must be set correctly prior to conversion to enhance accessibility.  

· Repairs to the Source File: Repairs made directly to the PDF file will be erased in subsequent PDF documents created from the same source file; therefore, it is recommended that all repairs/revisions are made to the source document and converted to PDF. 

· Repairs to the PDF File: a few repairs must be completed to the PDF file to improve accessibility.  This includes setting the document language, ensuring tab order is consistent with structure order and establishing headings for tables.



Continue to check the document until there are no more accessibility issues to report. 




Document Structure Tags



PDF tags are a mechanism for indicating the organizational structure of documents (e.g., headings, paragraphs, sections, tables, and other page elements) without changing the visual appearance of the PDF.  These tags enable use with assistive devices, such as screen readers, indicate the document reading order and also enable mobile devices to reflow and display the document on a small screen.



An untagged document does not have structural information, and Acrobat must infer a structure. This situation often results in page items being read in the wrong order or not at all.  For best results, tag the document when converting it to PDF from the authoring application.

To add tags automatically

1. Go to menu item: Advanced > Accessibility > Add Tags To Document

2. Note: This command removes any tags that were in the document before the command was run.  If any potential problems were encountered, an Add Tags Report appears in the navigation pane.



The automatic tagging feature is usually sufficient for most standard layouts, but it sometimes cannot correctly interpret the structure and reading order of complex page elements (e.g. closely spaced columns, irregular text alignment, and tables without borders.).  

If testing (see Technique 2) reveals problems, it is necessary to edit and add tags manually using the following techniques.

To add tags manually

1. Using the TouchUp Reading Order tool, drag within the document pane to select a region of the page that contains one type of content (e.g. a text block)

2. To add more page content to the current selection, Shift + drag

3. To remove page content from the current selection, Ctrl + drag

4. Select the appropriate button in the TouchUp Reading Order dialog to specify the tag type


Reading Order

The order in which elements in a document are read by assistive software is determined by the reading order.  Each section of page content appears as a separate highlighted region and is numbered according to its placement in the reading order.  You can change the reading order of the highlighted regions without changing the actual appearance of the PDF.  For example, by reordering highlighted regions on the page, you can make a figure and caption read at the specific point that they are referenced in the text without actually moving the elements on the page.

When to use the TouchUp Reading Order Tool

The TouchUp Reading Order Tool provides a quick and easy way of fixing reading order and tagging problems in a PDF document.  The TouchUp Reading Order Tool can be used for the following:



1. Check and repair reading order of content

2. Tag interactive form fields

3. Add alternative text to figures/images

4. Add alternative descriptions to form fields

5. Fix tagging of basic tables; and

6. Eliminate nonessential content from the tag tree (ornamental page borders)






The TouchUp Reading Order Tool provides the following options to users as part of the dialogue box:

· Show page content order: Page elements are shown as highlighted numbered regions.  The reading order of the document is associated with the sequence of the numbers on the highlighted regions.

· Show Table Cells: The content of individual cells are shown in highlighted regions. This option allows the user to view any rows and/or columns that have been incorrectly merged/split.

· Show Tables and Figures: Each table and figure in the document is outlined with a crossed-out box.  This option allows the user to view the boundaries of a table and shows the alternative text for each figure.

· Clear Page Structure: Tags from all visible pages will be removed.  This option can be used if a page contains too many tagging problems and the user wishes to start again.

· Show Order Panel: Selecting this option opens the Order Panel in the navigation pane. The order Panel can assist users with restricting and the reading order of the document.

· Table Editor:  By selecting this option, selected text will be automatically analyzed into cells with applicable tags.  Please note that in order to use the Table Editor option, the table must be tagged as such.

· Edit Alternative Text: When a figure is highlighted and the user right-clicks on it, the edit alternative text option can be chose.  This option allows users to edit or add a text description to a figure.

· Edit Form Field Text: When a user right-clicks on a form field, the edit form field text option can be chosen.  This option allows users to edit or add a text description to a form field. 

· Edit Table Summary: When user right-clicks on a highlighted table, the edit table summary option can be chosen.  This option allows users to edit or add a text description in regards to the table properties.




Document Language

In order for assistive technologies (e.g., screen readers) to be able to present your document accurately, it is important to indicate the natural language of the document.  If a different natural language is used for a paragraph or selected text, this also needs to be clearly indicated.

To change the default language

1. Go to menu item: File > Properties

2. Select the Advanced tab

3. In the Reading Options section, select the language from the Language drop-down list

4. Select OK

To apply a language directly to selected element

1. Go to menu item: View > Navigation Panels > Tags

2. In the Tags tab, select the element

3. Right-click* the element and select Properties…

4. In the Tag tab, select the language from the Language drop-down list

5. Select Close

Document Title

In case the document is ever converted into HTML, it should be given a descriptive and meaningful title. 

To change the title of the current document

1. Go to menu item: File > Properties

2. Select the Description tab

3. Enter a descriptive title in the Title box.  It is also helpful to enter descriptive information in the text boxes that follow (Author, Subject, Keywords or select Additional Metadata)

4. Select OK


Scanned Documents



Scanned documents are particularly difficult for assistive technology.  They appear as an image. Assistive Technology does not read images unless there accompanied by “alt text”.  Because a scanned document may be several pages long, it is impossible to provide adequate “alt text”.  It is important to ensure that you are always starting with a source document that is not scanned.



If you have a scanned document and do not have access to the original source document, in order to make the document accessible, you must run it through Optical Character Recognition (OCR).This feature can be found in all Professional versions of Adobe.



OCR will force Adobe to recognize the text.  Once OCR has been run, you can manually add tags and alter the reading order.



On occasion, the OCR tool cannot recognize all of the text within a document.  The tool, however, gives the user the ability to examine, confirm and correct questionable text in the document.



Searchable Text



Searchable text is an essential characteristic of an accessible PDF document. Assistive technology devices, such as screen readers, require documents to have searchable text to allow text to be converted into speech.  A document that has been scanned creates a graphic representation of the content which prevents the text from being searchable; therefore, making scanned images inherently inaccessible.  Users of screen readers cannot select or edit the text of a PDF document that is essentially a scanned image.
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